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Introduction of MS Office:  

MS-Office is the most up-to-date product of Microsoft which is mainly designed for 

Domestic/Official/Development purpose PC-Users. Microsoft has already launched this 

product as its older version like Office 4.3, Office 95, Office 97, Office 2000, Office 2002 

XP Professional, Office 2003 & latest Office 2007. Each Version launched with some new 

and advance options. The given editions are mainly available as per the requirements of 

users at different levels. The part software of MS Office 2000 & 2003 (currently in use) are 

listed as: 

1. MS-Access  

2. MS-Excel 

3. MS-InfoPath 

4. MS-Outlook 

5. MS-Power Point 

6. MS-Publisher 

7. MS-Word 

In older versions, MS info Path and MS publisher were not available. We have MS Front 

Page as web development tool in older versions which are to be installed separately in 

case of installation of MS Office 2003 and 2007.  

Word Processor: 

Any office starts with official works where more than fifty percent job work is 

documentation. For an Office word processing plays a vital role and to provide the quality 

result, the full preparation was done with typewriter but now-a-days the entire typewriter 

generation is being replaced by computer & word Processing Software. A Word Processor 

is a word processing tool which contains the entire facility & necessary provisions for any 

kind of documentation. In such circumstances the word processor software will be defined 

as software which helps to create and edit a document.  

Another term closely associated with word processing is desktop publishing. Software like 

MS Word combines text, page and graphic capabilities in ways that reveal the work of 

professionals. Hence, the term Desktop Publishing stands for the whole process of typing 

content, adding graphic and photos, laying out the pages in creative ways, and dashing it 

off to a printer. It is all done with the help of a desktop computer. We can’t do it 

manually. These facilities are also available with many word processing soft wares. The 

famous word processing Softwares are: 

1. MS-Word by Microsoft Inc., MS-Office 

2. Word Perfect by Novell by Novell Perfect Office 

3. AMIPRO by Lotus Inc., LOTUS SMARTSUITE etc. 

4. Page Maker by Adobe 

Some editor are also available like Word Pad, Notepad, Dos Editor in preparing the 

documentation part but they provide limited facilities which is not having more use in 

current advanced age. 

MS Word and its Application 

The Word 2003 application in the Office 2003 suite is the most powerful word processor 

currently being used by professional for documentation and editing.  

Word 2003 is software with new features that makes different form earlier versions. 

Hence we are equipped with latest features to create our own document to web page, 

take advantage of the new drawing tool, take advantage of the new editing features, and 

coordinate our project with excellent integration between word and another application.  

Features of Word Processor: 

Fast:  

Typing text in a word processor becomes speedy as there is no mechanical carriage 

movement associated. 

Editing Features:  

Any type of correction can be made easily as and when required. 

Permanently Storage:  

With word processors, document can be saved as long as desired. 
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Formatting Features:  

The typed text can be made to appear in any form of style (bold, italic, underline etc.).All 

this is possible due to formatting features of word processor.  

Graphics: Most modern word processors provide the facility of incorporating drawings in 

the document which enhanced their usefulness. 

OLE (Object Linked and Embedding):  

Most modern word processor provide facilities to link or embed objects in a document. 

OLE is a program-integration technology that we can use to share information between 

programs through objects. Objects are saved entities of different types like charts, 

equations, video clips, audio clips, picture etc. 

Spell check: 

Word processors are not only capable of checking spelling mistakes but also can suggest 

possible alternatives for incorrectly spelt words. Some word processors can check for 

grammatical mistakes and suggest alternatives or improvements. 

Mail Merge: 

The mail merge facility enables as to print a large number of letters/documents with more 

or less similar text.    

Starting MS-Word: Start »All Program » Microsoft Office » Microsoft Word 

 

 Window of MS Word & Its features: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Title Bar:   

It is located at the top of the window and it displays the name of the currently active Word 

Document. 

Menu Bar:   

It is located below the title bar. It has many options called menus. All the menus have 

many sub menus. These can be accessed by clicking the mouse at the option, or by 

moving highlighted bar to the options and pressing the enter key. 

Standard Tool Bar:  

It consists of most frequently used commands and utilities. 

Format Bar:   

Allows the user to format the text & Document directly with this bar 

Ruler Bar:   

The ruler bar allows to format the vertical alignment of text in a  

document. It can be also be used to set tab stops on a line of text. 

Drawing Tool Bar:  

This bar contains different types of drawing items. 

Status Bar:   

The status bar displays information about the active document or the task on which you 

are currently working. These include page number that is on, the column and line number 

on which you have positioned the cursor and so on. 
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Scroll Bar:   

Scroll bars are used to view different areas of the active document. We can do so by 

moving the elevator along the scroll bar or by clicking on the buttons with the arrows 

marked on them, to move up and down the page. 

Working space: 

The working space is the area in the document window wherein we enter the text of our 

document.  

Word Processing Terminology: 

Now that we have worked a little bit in Word, it’s time we learnt about varios terms in 

word-processing, their meanings and effects on the document. This section discusses the 

terminology of word processing.  

Margins: 

The margin is the distance from the text to the paper’s edge. The text and graphics are 

usually printed inside the margin. The ruler line in a word processor displays the positions 

of margins. 

The margins are of different type: 

Left Margin: This is the distance between the text and the left edge of the paper. 

Right Margin: This is the distance between the text and the right edge of the paper. 

Top Margin: This is the distance between the text and the top edge of the paper. 

Bottom Margin: This is the distance between the text and the bottom edge of the paper.  

Word Wrap: 

The word wrap feature place the text going beyond the right margin to the next without 

pressing enter key. (In word processors, the word wrapping is the fitting of text within the 

margins.) 

Indentation:  

The indent refers to the distance between text boundaries and page margin. There are 

three type of indents positive indent, negative and hanging indent. 

 

Typing tactics and text selection: 

In order to create a document, the text has to be typed. As the text is typed, it can be 

seen in the document window. A blinking cursor displays on the working space area where 

we can type our data. The following are the fundamental typing tactics. 

 Hit any key on key board and the related letters would appear at the location of 

the cursor. 

 As you keep on typing the cursor moves one space ahead. 

 To put a space between letter press space bar on key board. 

 To capitalize a letter press Shift Key + Letter Key. 

 To capitalize whole line use Caps Lock. Press Caps Lock key to apply Caps Lock. To 

release the Caps Lock, press Caps Lock key once again. 

 Cursor automatically comes to next line as the page width expires. To bring the 

cursor to the next line from current line in between, press Enter /Return key. 

 To delete any letter right to the cursor press Delete Key on key Board. Similarly to 

delete a letter left to the cursor press Back Space key. 

 To bring whole lines upward, place the cursor at the beginning of the line and press 

Back Space key repeatedly. Similarly to bring whole lines downwards, place the 

cursor at the beginning of the line and press Enter key repeatedly. 

 

To select the text we can use the arrow key with shift key or drag the mouse and select 

the entire data. 

Text editing viz. Cut, Copy, Paste, Delete etc.: 

Correction of Mistakes is called editing. Editing text is an essential feature of a word 

processing package. Word will indicate us about the misspelled in the documents, and we 

have the option of editing manually/automatically. 

 

Formatting tool bar options: 

 Font style :   To change the style of font as : Regular, Bold, Italic 

 Font type:  To change the type of font as: Times New Roman, Arial, etc. 

 Font size:  To change the size of font as: 10, 12, 14 …… 
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 Bold (B) :  To make the text bold 

 Italic (I):  To make the text italicize. 

 Underline (U): To make the text Underline 

 Alignments : There are four alignments (Left, Centre, Right & Justify) 

 Bullets and Numbering: To give the bullet or number on selected text. 

 Font Color: To change the Color of text. 

 Format Painter: To apply the formatting same as the given text formatted. 

 Indentation: To set the position of indent (Left Indent, Right Indent) 

Opening and saving files and description of file menu, Page setup and Print 

preview. 

 

File Menu:  

This menu consists of the various options regarding the operations of the file. These 

options are use to manipulate or either use the file different ways. The various options of 

the file menu are as follow: 

New, Open, Close, Save, Save as.., Save as web page, file search, permission, web page 

preview, version, page setup, print preview, print, send to, exit & 4 recently used files. 

New:  If a new document (Bank or Template or Web Page) to be created them you have 

to this option. 

Open: If an existing document is to be opened, then we have to use this option. 

Save:  This option is used to save the opened document. 

Save As: The “save as…” option is use to save the document with another name, or at  

another location with same name or at another location with another name. 

Page Setup: This option gives you information regarding the page. Information  

means the details regarding the margins, the position of the page on paper etc.,  

would be modified or created. 

Print Preview: This would show you the preview of your page which you would like  

to take a printout.  

Print: This option is used to take a printout of your document created. 

 

Edit Menu:  

This menu contains all the option which is used to modify or change the attributes of the 

created document in a normal way and for that purpose it is called as an edit menu. The 

options available under this menu are following: 

Undo, Repeat, Cut, Copy, Paste, Office clipboard, Paste as Hyperlink, Paste Special, Clear 

All, Find, Replace, Go to, Link, Object. 

Undo: The changes made to a document, such as editing, formatting, check spelling and 

inserting breaks, Footnote and tables. Undo has to remove the last changes taken place in 

the document. 

Repeat: Repeats the last change you made in a document, such as editing, formatting, 

checks of spelling and inserting breaks, Footnote and tables. The repeat command 

changes to can’t repeat if you want to bring the last action. You can use this command to 

quickly add a sentence or made the same revision in several place in a long document. 

When you use the undo command to reverse and action, the repeat command change to 

repeat. 

Find:  To find out methodologies for finding text. 

Replace: With the replace command, you can find and replace text or formatting you  

can automatically replace all occurrences of the found text, or selectively replace only 

certain instances. For information on replacing formatting. 

 

View Menu:   

This menu options mainly available with view option of documents. 

Normal View, Web Layout View, Print Layout View, Outline View, Reading Layout, Toolbar, 

Ruler, Task Pan, Document Map, Thumbnails, Header & Footer, Footnote, Comment, Full 

Screen, Zoom.   

Toolbars: We can activate the existing toolbars which will be available with all the toolbar 

options. There are 16 nos. of toolbar available under this toolbar. With the toolbar option 

we have option that we can create a new toolbar with selected toolbar. Under 
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customization of toolbars. Some available toolbars are Standard, Formatting, Database, 

Clipboard etc. 

Ruler: Display or hides the horizontal ruler a bar with a measurement scale and marks 

that enable you to adjust indents, margin, tab stop and table columns. 

Header & Footer: Add or changes text that word repeats at the top of every page 

(Header) or to the bottom of every page (Footer) in a section or in an entire document. 

Header & Footer offers lots of flexibility in the way page numbers and other document 

statistics can be displayed. 

 

Insert Menu: 

This menu is allows us to insert certain objects and items while creating a document. 

The options of insert menu are as following:  

Break, Page No., Date & Time, Auto Text, Field, Symbol, Comment, Reference, Web 

Component, Picture, Diagram, Text Box, File, Object, Hyperlink, Bookmark. 

Page No.: This option would be chosen to insert the page no. in the document. 

Date & Time: This is use to insert the date & time values in the document opened. 

Bookmark: Bookmark let you quickly jump from place to place in document. Instead of 

paging up or down through your document. 

 

Format Menu:  

The format menu is mainly available with following formatting options: 

Font, Paragraph, Bullets & Numbering, Border & Shading, Columns, Tab, Drop Cap, 

Direction, Change Case, Themes, Auto Format, Formatting & 

Style, Frames, Reveal Formatting. 

Font : This option is used to change the font style, font type, 

font size, font Color, Underline style & Color, Strikethrough, 

double strikethrough, Super Script, Subscript, Shadow, 

Outline, Emboss, Engrave, Small caps, All caps, hidden. To 

change text whose appearance you want to change.  

1. On the Format menu, click Font, and then click the 

Font tab.  

2. Choose the font characteristics in the set of controls 

that applies to the language type of your selected 
text.  

Paragraph: We can change the spacing between the lines or 

the spacing before or after each paragraph, Indent and 

alignment for the text. 

Bullet & Numbering: Microsoft Word can automatically 

create bulleted and numbered lists as you type, or you can 
quickly add bullets or numbers to existing lines of text. 

Border & Shading: Borders, shading, and graphic fills can 

add interest and emphasis to various parts of in the 

document. We can add borders to pages, text, tables and 

table cells, graphic objects, pictures, and Web frames. We 

can shade paragraphs and text. We can apply Colored or 
textured fills  

Change Case: We can change the case of the text as Capital, small, toggle, sentence 
case, Title case. 

Tools Menu:  

Tools menu is used to setup the changes & features of document. 
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Spelling & Grammar, Research, Language, Speech, Share Workspace, Compare & Merge 

Document,   Word Count, Auto Summarize, Auto Correct, Track Changes, Protect 

Document, Online Calibration, Letter & Mailing, Macro,  

Templates-Add-ins.., Option, Customize 

Spelling & Grammar: Word 2003 has a wonderful spelling & Grammar checker that can 

have you draft your document error free. It can be show red underline on spelling error 

and green line to the grammatical error. You can check the mistake by pressing F7 key it 

suggest the correct spelling & grammatical mistakes and also you can ignore the error and 

ignore all of the same error go on to the next sentence or accept the suggested changes. 

Mail Merge: We can use the mail merge facility to create from letters, mailing labels, 

envelopes, or catalogs. The mail merge guides you through organizing the address data, 

merging it into a generic document, and printing the resulting personalized document. 

Use the Mail Merge task pane to create form letters, mailing labels, envelopes, 

directories, and mass e-mail and fax distributions. To complete the basic process, you: 

 

Mail Merge Facility using these steps 

Step 1:  Select the document type  

(Select letters to a group of people you can personalized the letter or other document that 

each person receives.) 

 

 Letters 

 Email Massages 

 Envelopes 

 Labels 

 Directory 

Step 2: Select Starting Document  

(Start from the document shown here and use the mail merge wizard to add recipient 

information.) 

 

 Start the current document 

 Start from Template 

 Start from Existing Document 

 

Step 3: Select Recipients  

(Select of type the list of recipients that you have to send the letter or that document you 

are created) 

 Use an existing list 

 Select from Outlook contacts 

 Type a new list 

Step 4: Write your letter  

(Type the letter or the document information you have to send it)  

Step 5: Preview of your letter 

(One of the merged letters is previewed here. To preview another letter choose next 

option.) 

Step 6: Complete the merge 

(Now the document is ready to produce the merge document and this will be open in a 

new document with your merged letters or document) 

Wizard:  

A feature that asks questions and then creates an item, such as a form or Web page, 

according to your answers is called as a wizard.  

 

Template:  

A file or files that contain the structure and tools for shaping such elements as the style 

and page layout of finished files are called as a template. For example, Word templates 

can shape a single document, and FrontPage templates can shape an entire Web site.  
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Table Menu: 

A table is a made up of rows and columns of cells that you can fill with text and graphic. 

Tables are often used to organize and present information. There are two types of table 

symmetrical & Non-symmetrical. 

Draw Table, Insert, Delete, Select, Merge Cell, Split Cell, Split Table, Table Auto Format, 

Auto Fit, Heading row repeat, Convert, Sort, Formula, Hide Gridlines, Table Properties. 

Draw Table: You can draw a complex table— for example, one that contains cells (cell: A 

box formed by the intersection of a row and column in a worksheet or a table, in which 

you enter information.) of different heights or a varying number of columns per row. 

1. Click where you want to create the table.  

2. On the Table menu, click Draw Table.  

 

 

 

 

 

The Tables and Borders toolbar appears, and the pointer changes to a pencil. 

To define the outer table boundaries, draw a rectangle. Then draw the column and row 

lines inside the rectangle. To erase a line or block of lines, click Eraser on the Tables and 

Borders toolbar, and then click the line you want to erase.  

3. When you finish creating the table, click a cell and start typing or insert a graphic.  

Note Hold down CTRL to automatically apply text wrapping while you draw the table. 

Using the draw table option we can change or draw the Line style of table, Line width, 

border Color, outside border, shading Color, insert table, merge cell, split cell, alignment 

of table, distributes row evenly, distribute column evenly, table auto format, sort order, 

direction, formula. 

Insert Table: To create a simple table by using the insert table command. Use this 

procedure to make choices about the table dimensions and 

format before the table is inserted into a document. 

1. Click where you want to create a table. 

2. On the Table menu, point to Insert, and  

then click Table. 

3. Under Table size, select the number of  

columns and rows. 

4. Under AutoFit behavior, choose options to  

adjust table size. 

 

Merge Cell: Merge cells into one cell in a table 

You can combine two or more cells in the same row or column 

into a 

single cell. For example, you can merge several cells horizontally to create a table heading 

that spans several columns. 

On the Table menu, click Merge Cells. 

Note When you merge several cells in a column to create a vertically oriented table. 

Split Cell: 

We can add two or more than two cell, row or column by using the                                  

split cell option. Click in a cell, or select multiple cells that you want to  

Split. On the Table menu, click Split Cells. Select the number of columns or rows you 

want to split the selected cells into.  

Split Table: Split a table 

1. To split a table (table: One or more rows of cells commonly used to display 

numbers and other items for quick reference and analysis. Items in a table are 

organized into rows and columns.) in two, click the row that you want to be the 

first row of the second table.  

2. On the Table menu, click Split Table.  

Drawing Toolbar: 

 This bar contains different types of drawing items. 
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Draw menu: Draw menu contain the options to set/edit/format the inserted object. 

Select Tool:  To select any object inserted in the document. 

Auto Shapes: To insert the different types of shapes and drawings in our document. 

Line:   This tool is used to draw a line. 

Arrow:  This tool is used to draw an arrow 

Rectangle:  This tool is used to draw a rectangle. 

Oval:   This tool is used to draw a oval or circle. 

Text Box:  This tool is used to make a box with facility of typing. 

Word Art:  It’s a utility of ms-word which has to insert our text in design format. 

Diagram:  This tool is used to insert a diagram in our document. 

Clip Art:  The Microsoft Clip Organizer contains drawings, photographs, sounds,  

videos, and other media files — called clips — that you can insert and use in 

presentations, publications, and other Microsoft Office documents. 

Insert Picture: By default, Microsoft Word embeds pictures in a document. You can  

Insert Picture from your own created document or saved files. 

Fill Color:  There are two basic types of graphics that you can use to enhance your  

Microsoft Word documents: drawing objects and pictures. Drawing objects 

include AutoShapes, diagrams, curves, lines, and WordArt drawing objects. 

These objects are part of Word document. Use the Fill Color Option to 

change and enhance these objects Colors, patterns and other effects. 

Line Color:  This tool is used to change the an object outline Color. To change to the 

default Color, click Automatic. To change to another Color, click one of the 

Colors below Automatic. To change to a Color that isn't displayed, click 

More Line Colors. Click the Color you want on the Standard tab, or click 

the Custom tab to mix your own Color, and then click OK. 

Font Color: This option is used to change the Color of the selected text of an  

document. If you want to change the Color of text select the text you want 

to change. Do one of the following:  

 To apply the Color most recently used for text, click Font Color on the Drawing 

toolbar. 

 To apply a different Color, click the arrow next to Font Color, and then select the 

Color you want. 

Line Style:   Line style option is used to change the selected line style and 

pattern. 

Dash Style:   This option is used to change the selected line in a dash line. 

Arrow Style:  This option is used to change the selected line in a arrow line style. 

Shadow Style:  To change a shadow, you can choose a different shadow style. To  

 

 Modify settings for the current shadow, do one of the following: 

1. Select the drawing object you want to change.  

2. On the Drawing toolbar, click Shadow, and then click Shadow Settings.  

3. On the Shadow Settings toolbar, click any of the four Nudge Shadow buttons 

to create the effect you want. Clicking a Nudge Shadow button nudges the 

shadow 1 point. To nudge the shadow 6 points, hold down SHIFT while you click a 

Nudge Shadow button. 

3-D Style:  This option is used to give a shadow on the selected object. Select the  

Object you want to change. 

On the Drawing toolbar, click 3-D Style, and then click 3-D Settings. 

On the 3-D Settings toolbar, click the arrow next to 3-D Color.  

Do one of the following:  

1. To change the 3-D Color back to its default, click Automatic.  

2. To change to a Color in the Color scheme, click one of the Colors below 

Automatic. 

3. To change to a Color that isn't in the Color scheme, click more 3-D Colors. 

Click the Color you want on the Standard tab, or click the Custom tab to 

mix your own Color, and then click OK. 


